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Revision History 

Revision Date Description 

H.0 10 September 2021 Updates in Torrent Suite™ Software 5.12.3 for compatibility with new motherboard 
on Ion GeneStudio™ S5 sequencers, and to fix issues with the Apache Tomcat™ 
software service, the CSA plugin, and the pump on the Ion Chef™ Instrument. 

G.0 1 September 2020 Updated fixed issue in Torrent Suite™ Software 5.12.2. 
F.0 23 March 2020 Corrected package version numbers for 5.12.1. 
E.0 27 February 2020 Updated fixed issues in Torrent Suite™ Software 5.12.1. 
D.0 16 December 2019 Corrected package version numbers for 5.12.1. 
C.0 31 October 2019 Updated release notes for Torrent Suite™ Software 5.12.1. 
B.0 22 July 2019 Corrected package version numbers for 5.12.0. 
A.0 25 June 2019 New release notes for Torrent Suite™ Software 5.12.0. 
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Torrent Suite™ Software 5.12.3 release 

Software update to support Ion GeneStudio™ S5 sequencer motherboard 
The release enables users to run Torrent Suite™ Software 5.12.3 with Ubuntu 18.04 operating system 
on newly manufactured Ion GeneStudio™ S5 sequencers. The original motherboard on the 
sequencers was discontinued and replaced. Contact your Field Service Engineer (FSE) to obtain this 
software release. 

Fixed Issues in Torrent Suite™ Software 5.12.3 
Correct the analysis time for Ion™ 550 chip on Ion GeneStudio™ Prime and S5 XL instruments 
After the Ion Torrent Server was upgraded to Ubuntu 18.04, some customers noticed an increase in 
the time required for the analysis pipeline to complete for runs that used an Ion 550™ chip. This issue 
is fixed in Torrent Suite™ Software 5.12.3. 

Status of Tomcat service displayed incorrectly 
In Torrent Suite™ Software 5.12 the status of the Apache Tomcat® software service was displayed 
incorrectly. The status in the Services screen showed that Tomcat® software service was down, 
although the service was active. This issue is fixed in Torrent Suite™ Software 5.12.3. 

CSA permission error is fixed on Ion Chef™ Instrument  
An error 500 occurred when the CSA (Customer Support Archives) was downloaded. This issue is 
fixed in Torrent Suite™ Software 5.12.3. Users can now run the CSA plugin to generate the CSA file in 
Torrent Suite™ Software. 

Pump issue on Ion Chef™ Instrument  
An issue of excess aspiration was reported that was caused liquid to flow to the pump on an Ion 
Chef™ Instrument. A new script in the software corrects excess aspiration of the library preparation 
workflow with the 550 templating script on Ion Chef™ Instrument. This issue is fixed in Torrent 
Suite™ Software 5.12.3. 

Fixed Issue in Torrent Suite™ Software 5.12.2 

“Reagent Check Failed” message when initializing with the Ion 550™ chip fixed 
When initializing instruments with the Ion 500™ chip, users saw a “Reagent Check Failed” error 
message. The issue is fixed in Torrent Suite™ Software 5.12.2. 

Fixed Issues in Torrent Suite™ Software 5.12.1 

variantCaller plugin reported same allele multiple times for a given variant 
In rare cases, the variantCaller plugin, running in Torrent Suite™ Software 5.12 on the Ubuntu 18.04 
operating system, produced variant calls with an alternate allele reported multiple times for a given 
variant. This caused incorrect generation of the output VCF file record resulting in the variantCaller 
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plugin failing/skipping the corresponding sample, and generating a result table for the sample. The 
issue is fixed with the installation of the updated Suite™ Software 5.12.1. 

Torrent Suite™ Virtual Machine (TSVM) reboot/stall during analysis on S5 sequencers 
On some Ion S5TM and Ion GeneStudioTM S5 sequencers, Torrent Suite™ Software running on a virtual 
machine stalls or stalls and restarts during run analysis. In both cases the run does not complete and 
the user would need to manually start the reanalysis. This issue is fixed with the installation of 
Torrent Suite™ Software 5.12.1. 

Basecalling input data deleted by scheduled Data Management auto action 
On some systems, it was observed that the basecalling input data was deleted by data management’s 
auto action when all results were older than the configured data management threshold. This issue is 
fixed with the installation of Torrent Suite™ Software 5.12.1. For more information on the 
configuration of the data management auto action, see the Torrent Suite™ Software help system. 

  



Torrent Suite™ Software 5.12 Release Notes 6 

New features in Torrent Suite™ Software 5.12.0 

Support added for new Ubuntu Operating System (OS) 
With the release of Torrent Suite™ Software version 5.12.0, support is added for Ubuntu Operating 
System (OS) 18.04. Torrent Suite™ Software 5.12.0 also continues to be supported on and is available 
on the current version, Ubuntu OS 14.04. Therefore, you have the option to remain on the current 
OS version, upgrade to 18.04 now, or upgrade at a future date. No further security updates will be 
published by Ubuntu for the 14.04 version of the OS. To continue to receive security updates with 
future software updates, upgrading to Ubuntu OS 18.04 with Torrent Suite™ Software 5.12.0 is highly 
recommended. See section “Important Information” for additional details. 
 

molecularCoverageAnalysis plugin launched 
The new molecularCoverageAnalysis plugin provides coverage analysis, QC metrics and visual results 
that are specialized for the Ion AmpliSeq™ HD and Tag Sequencing chemistries. With the addition of 
this plugin that is dedicated to the coverage analysis, the variantCaller plugin has been modified to 
remove coverage related metrics to avoid duplication of information and confusion. 
 
An example report from the molecularCoverageAnalysis plugin is as follows: 
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variantCaller plugin now allows specifying minimum callable probability parameter for 
Limit of Detection (LOD) calculation 
For Tag Sequencing and AmpliSeqTM HD assays, the variantCaller plugin now allows users to specify 
the minimum detectable probability for the calculation of Limit Of Detection (LOD) using the  
“min_callable_prob” parameter. LOD is defined to be the lowest possible allele frequency in the 
sample, such that the variant is callable with probability higher than the “min_callable_prob” value, 
when molecular depth is given. In TSS 5.10, the default value of the “min_callable_prob” parameter 
was set to 0.98 for AmpliSeqTM HD and Tag Sequencing assays. In TS 5.12, the default values of 
“min_callable_prob” parameter is set to 0.95 and 0.8 for AmpliSeqTM HD and Tag Sequencing, 
respectively. As a result, the variantCaller plugin may report lower values for LOD in version 5.12 
than 5.10, when analyzing the same dataset with the default parameters. 
 
Access this parameter setting in the Data > Completed Runs & Reports screen. Click the report name 
link for the completed sequencing run, click Plugins > Select Plugins to run, select the variantCaller 
plugin, then click Configure. Adjust the parameter as appropriate. 
 

 

variantCaller plugin results view change 
For Ion AmpliSeq™ HD applications, the Median Read Coverage and Median Molecular Coverage 
columns have been moved from the variantCaller plugin results view to the results view of the new 
molecularCoverageAnalysis plugin.  
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Sequence Variant Baseline (SVB) BED file support added 
You can used advanced settings to point to path of the SVB BED file Use this setting to avoid 
unwanted interactions of hotspots with surrounding sequences, with variantCaller plugin is 
supported in Torrent Suite™ Software 5.10.0.  
Access this parameter setting in the Data > Completed Runs & Reports screen. Click the report name 
link for the completed sequencing run, click Plugins > Select Plugins to run, select the variantCaller 
plugin, then click Configure. Adjust the parameter as appropriate." 

 

Change to Limit of Detection for called alleles  
For Ion AmpliSeq™ HD applications, the output VCF files from sequencing runs that use the default 
variantCaller settings now display in the Limit of Detection setting as “.” for alleles reported as 
present.  

Redesigned panel import, from Ampliseq.com, user flow for enhanced user experience 
The Torrent Suite™ Software 5.12.0 user interface is redesigned to increase usability, present 
relevant information, and reflect the user experience of Ampliseq.com. In addition to improved 
layout of the panel information that is displayed, easy navigation and filtering capabilities are added 
to the panel import view. 
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Support added for new telemetry service 
A new telemetry service has been added to provide Torrent Suite™ Software with connectivity to 
Thermo Fisher Connect. This connectivity allows authorized Thermo Fisher Scientific personnel to 
provide remote troubleshooting service and support upon request. 
To enable or disable these telemetry services, click  (Settings) > Services, then scroll down to the 
Telemetry Services section. 
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Barcode kit updated for Precision ID human identification (HID) templates 
The Precision ID HID planned run templates that have been updated use IonCode™ as the barcode 
kit. The following templates were updated: 
 
Templates  
Precision ID mtDNA Control Region Panel—
S5 

Precision ID mtDNA Control Region Panel—PGM 

Precision ID mtDNA Whole Genome Panel—
S5 

Precision ID mtDNA Whole Genome Panel—PGM 

Precision ID Ancestry Panel—S5 Precision ID Ancestry Panel—PGM 
Precision ID Identity Panel—S5 Precision ID Identity Panel—PGM 

System memory now displayed on System Services screen 
The System Services screen now includes the display of system memory usage information at the 
bottom of the screen. This information helps with monitoring and troubleshooting. 
To view the system memory usage, click  (Settings) > Services, then scroll to the System Memory 
Usage section. 

 

Ion Chef™ Instrument added run calibration support and instructions to replace UV bulb 
With the release of Torrent Suite™ Software 5.12.0, Ion Chef™ Instrument calibrations are now 
enabled for optional use by the customers. In addition to this feature release, instructions on how to 
replace the UV bulb in the Ion Chef™ Instrument are also made available to customers. 
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Fixed issues in 5.12.0 

0variantCaller plugin UI displays incorrectly Torrent Variant Caller (TVC) version 
On some systems, when off-cycle updates of Torrent Suite™ Software were installed, the TVC version 
displayed incorrectly in the variantCaller plugin user interface. This was a display issue only; the 
version of TVC used by the analysis pipeline was correct. 

Centrifuge hardware failure event on Ion ChefTM Instrument causes runs to abort 
On some systems, centrifuge failure events were observed at the end of the certain spins in the run 
protocol. The centrifuge failed to recover from the failure event, resulting in implicated runs to abort.  

Truncated sample list in run report PDF 
When a PDF of a run report is generated, the "Analysis Details" section might show a sample list that 
is truncated on a page if a large number of samples were used in a single run. This issue will be fixed 
in an upcoming release of the software. 

Variant information in O-tags (OID, OPOS, OREF, OALT) of VCF off by 1 base 
If padding is used when specifying alleles in a hotspot BED file, the reported variant information in 
the O-tags may be off by 1 base. This issue will be fixed in an upcoming release of the software. 

Incorrect values listed in PPD and SPD tags in VCF file 
In some cases, the values reported in the newly added PPD and SPD tags, for prefix and suffix 
paddings used for reported alternate alleles, can be incorrect in the VCF file from sequencing runs. 
Do not use the values until a fix is issued in an upcoming software update. 

Deck scan fail on Ion Chef™ Instrument when empty tip rack is not detected 
In some cases, the deck scan may fail and display the “Waste Tip Rack Not Found” message when an 
empty tip rack is present but is still not detected as present. 
“Load check was unable to confirm the presence of all consumables and/or vision inspections, Press 
the Notifications button in the main menu for details.”   
If the empty tip rack is present, simply press the Continue button and proceed with the run. This 
issue will be fixed in an upcoming release of the software.  
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Important information in Torrent Suite™ Software 5.12.0 and higher 
release 

Upgrading Ubuntu Operating System (OS) 
The Torrent Suite™ Software 5.12.0 and higher release is available for all supported instruments on 
the current, 14.04, as well as the new, 18.04, versions of Ubuntu. 

Ubuntu Upgrade to 18.04 
Ubuntu is the operating system required for Torrent Suite™ Software, and after the end of support of 
version 14.04 in April 2019, there will no longer be new updates provided for that version of Ubuntu. 
However, we may continue to provide patch updates for the Torrent Suite™ Software 5.12.0 and 
higher as needed for critical issues/defects. To continue to receive new updates for the Ubuntu OS, 
upgrading to Ubuntu 18.04 is recommended. 

Ubuntu Upgrade Options 
Because Torrent Suite™ Software 5.12.0 and higher is available on both 14.04 and 18.04 versions of 
Ubuntu, it is possible to upgrade Torrent Suite™ Software to version 5.12.0 and higher without 
upgrading Ubuntu OS from 14.04 to 18.04.  
 
IMPORTANT! Torrent Suite™ Software 5.12.0 and higher will be the only Torrent Suite™ Software 
available on Ubuntu 18.04. Older versions of Torrent Suite™ Software are not supported on Ubuntu 
18.04.  

 
The following options are available for upgrading the Ubuntu OS: 

1. Upgrade Service—On-site OS upgrade done by your local Field Service Engineer. Contact 
local service and support personnel to request the upgrade service. 

2. Self-upgrade Kit—For performing the OS upgrade yourself. 
 
Ion Torrent Platform Upgrade options Availability 
Ion PGM™ System 
Ion Proton™ System 
Ion S5™ XL System 
Ion GeneStudio™ S5 Prime System 

Upgrade Service June 2019 
Self-upgrade Kit December 2019 

Ion S5™ System 
Ion GeneStudio™ S5 System 
Ion GeneStudio™ S5 Plus System 

Upgrade Service Only 1 December 2019 

 

 
 
1 Due to the additional complexity involved in updating devices running TSS in a Virtual Machine, the self-upgrade option is not available 
for these systems. 



Torrent Suite™ Software 5.12 Release Notes 13 

Install the update for Torrent Suite™ Software 5.12.0 and later 
 
IMPORTANT! You cannot roll back to a previous version of Torrent Suite™ Software and Ion 
Torrent™ instrument software after you perform the upgrade described in this document. 

 
IMPORTANT! When updating Torrent Suite™ Software, it is critical that you update both the 
software on the instrument and the software on the Ion Torrent™ Server. In Torrent Suite™ Software 
4.0 and later, the instrument will not retrieve the proper on-instrument analysis if both systems are 
not updated. 

 
IMPORTANT!  During this upgrade, you must use the same user account for both the Ion Torrent™ 
Server and the Ion instruments (Ion PGM™ Instrument, Ion Chef™ Instrument, Ion Proton™ 
Sequencer, Ion GeneStudio™ Plus S5, Ion GeneStudio™ S5 Prime, and Ion S5™ and S5™ XL 
Sequencers). 

Use these steps to install Torrent Suite™ Software 5.12.0. 

 
1. Sign in to Torrent Suite™ Software as ionadmin user. 

2. Click  (Settings) > Services. Ensure that there are no active jobs running. 

3. Click  (Settings) > Configure > Admin Interface. 

4. Click Update Server. 

5. Click Check to check for updates. 

6. When the Available message appears, click Update Server to start the update process. 

7. On the EULA screen, scroll down to read, then accept the EULA to begin update. 

8. When finished, ensure that the “Upgrade completed successfully!” message appears. 
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Updates through a command-line user interface 

Note: This procedure is typically performed by Thermo Fisher Scientific field service engineers. Most 
users will instead use the procedure above for updates through the Torrent Suite™ Software. 

New in this release, for Ubuntu™ 14.04 systems, the command-line interface update procedure has 
an additional TSconfig step of TSconfig --configure-server. The complete command-line interface 
update procedure is: 

1 
2 
3 
4 

sudo apt-get update 
sudo apt-get install ion-tsconfig 
When prompted to accept EULA acceptance, press “Tab”, then “Return” to proceed with update. 
sudo TSconfig -s 

5 sudo TSconfig --configure-server 

Verify the software update on the Ion Torrent™ Server 
To verify that the Ion Torrent™ Server is running Torrent Suite™ Software 5.12.1, click  (Settings) > 
About in the Torrent Suite™ Software and review the version number. 

Update the instrument software 
Update the software on any Ion instruments in use: 
  
• Ion Proton™ Sequencer 

• Ion GeneStudio™ S5 Sequencer 

• Ion S5™ and S5™ XL Sequencer 

• Ion Chef™ Instrument 

• Ion OneTouch™ 2 Instrument 
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Package and version information 

Release Date September 2021 

Release Version 5.12.3 

 

Software packages versions in 5.12.3 
These tables list the versions for each of the latest software packages for Torrent Suite™ Software 
plugins and Ion Torrent™ instruments. 

Package Version 

ion-analysis 5.12.28-1 

ion-dbreports 5.12.63-1 

Ion-djang0 5.12.0-1 

ion-gpu 5.12.2-1 

ion-pipeline 5.12.21-1 

ion-plugins 5.12.15-1 

ion-publishers 5.12.2-1 

ion-rsmts 5.12.6-1 

ion-torrentpy 5.12.22-1 

ion-torrentr 5.12.24-1 

ion-tsconfig 5.12.26-1 

Plugin Version 

ion-plugin-ampliseqrna 5.12.0.1 

ion-plugin-assemblerspades 5.12.0.0 

ion-plugin-coverageanalysis 5.12.0.0 

ion-plugin-dataexport 5.12.0.0 

ion-plugin-erccanalysis 5.12.0.0 

ion-plugin-fieldsupport 5.12.0.2 

ion-plugin-fileexporter 5.12.0.0 
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Package Version 

ion-plugin-filterduplicates 5.12.0.0 

ion-plugin-immuneresponserna 5.12.0.1 

ion-plugin-ionreporteruploader 5.12.0.40 

ion-plugin-molecularcoverageanalysis 5.12.0.32 

ion-plugin-pgxanalysis 5.12.0.0 

ion-plugin-runtransfer 5.12.0.0 

ion-plugin-sampleid 5.12.0.0 

ion-plugin-variantcaller 5.12.0.4 

Ion Chef™ Instrument Control Software in 5.12.3 
 

Package Version 

ion-chefupdates 5.12.5 

Package Version 

GUI 120011 

IS 000906 

SC 000906 

GM 000023 

OS 000061 

TsLINK 6.0.6 
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Ion GeneStudio™ S5/Ion S5™ Instrument Control Software in 5.12.3 
 

Update Package Version 

ion-s5updates 5.12.6 

Package for Ubuntu 18.04 Operating System Version 

Scripts 020146  

RaptorScripts 000131  

RsmAgent 40 

RfidMgr 000034 

OIA 051231 

LiveView 2762 

Graphics 134 

DataCollect 3970 

Package for Ubuntu 14.04 Operating System Version 

Scripts 020142  

RaptorScripts 000131  

RsmAgent 40 

RfidMgr 000034 

OS 35 

OIA 051231 

LiveView 2762 

Graphics 134 

DataCollect 3970 

Ion Proton™ Instrument Control Software in 5.12.3 

Update Package Version 

ion-protonupdates_5.12.0_amd64.deb 5.12.0 

Package Version 
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Update Package Version 

datacollect 3738 

Graphics 134 

LiveView 2514 

OIA 51206 

OS 35 

rsmagent 40 

Scripts 2.1.46 

Ion PGM™ Instrument Control Software in 5.12.3 

Update Package Version 

ion-pgmupdates 5.10.0 

Package Version 

LiveView 755 

DataCollect 489 

HW8560 134 

Scripts 220000 

OS 21 

Graphics 36 

TSLink 1.0.5 

Ion OneTouch™ Instrument Control Software in 5.12.3 

Update Package Version 

Ion-onetouchupdater 5.0.2-1 

Package Version 

OneTouch 803 

BoardControl 800 

UpdateAgent 800 
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Update Package Version 

Ion-onetouchupdater 5.0.2-1 

Package Version 

Scripts 802 

Psplash 800 
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